### Contents

**Contents** ............................................................................................................................................................. ii

**VISUAL Liquid Web COV Generic User User Manual** ................................................................. 1
- Disclaimer of Warranty ................................................................................................................................. 1
- Trademarks .................................................................................................................................................. 1
- Copyrights .................................................................................................................................................... 1
- System Requirements ................................................................................................................................. 2

**About** ........................................................................................................................................................ 3
- Text Conventions ........................................................................................................................................ 3
- Graphic Alerts ............................................................................................................................................. 3

**Getting Started** ................................................................................................................................. 4
- Accessing VISUAL Liquid Web ................................................................................................................... 5
- Closing the VISUAL Liquid Web Application ............................................................................................. 7
- Accessing Technical Support ....................................................................................................................... 7

**Navigating VISUAL Liquid Web** ........................................................................................................ 8
- Menus ........................................................................................................................................................... 9
- File ............................................................................................................................................................... 9
- Edit ............................................................................................................................................................. 9
- Toolbar ....................................................................................................................................................... 10
- Standard Buttons ................................................................................................................................... 10
- Content Pane ............................................................................................................................................ 11
- Left Pane .................................................................................................................................................. 12

**Using VISUAL Liquid Web** ............................................................................................................. 13
- Entering a New EAR ................................................................................................................................ 13
- Data Entry Features ................................................................................................................................. 20
- Submitting an EAR ................................................................................................................................. 21
- Requesting a Submission Notification Email ........................................................................................... 22
- Closing an EAR ....................................................................................................................................... 22
- Printing an EAR ...................................................................................................................................... 23
- Viewing/Updating an Open EAR ............................................................................................................... 25

**Index** ....................................................................................................................................................... 26
Disclaimer of Warranty
Avizent™ and its affiliates are committed to providing the best quality product possible, but specifically disclaim warranty of any kind and shall not be liable for loss of profit or any other damages. The Avizent software, its modules and the contents of this manual are provided as is and are subject to change without prior notice. The information contained in this document represents the current views of Avizent on the issues discussed as of the date of publication. This manual describes available modules and sub-applications for Avizent products, including items which may not be included in the base delivery model, which may be optional or which may be separately priced. Because Avizent must respond to changing market conditions, it should not be interpreted to be a commitment on the part of Avizent, and Avizent cannot guarantee the accuracy of any information presented after the date of publication.

Trademarks
The VISUAL Liquid Web software product and the VISUAL Liquid Web logo are trademarks of Avizent in the United States and/or other countries. All rights reserved. All other product names and services used throughout this manual are trademarks of their respective companies.

Copyrights
Complying with all applicable copyright laws is the responsibility of the user. Without limiting the rights under copyright, no part of this document may be reproduced, stored in, or introduced into a retrieval system, or transmitted in any form or by any means (electronic, mechanical, photocopying, recording, or otherwise), or for any purpose, without the express written permission of Avizent.

Avizent may have patents, patent applications, trademarks, copyrights, or other intellectual property rights covering subject matter in this document. Except as expressly provided in any written license agreement from Avizent, the furnishing of this document does not give you any license to these patents, trademarks, copyrights, or other intellectual property.

© 2008 Avizent. All rights reserved.

Any example companies or persons depicted herein are fictitious. No association with any real company or persons is intended or should be inferred.
System Requirements
The following table outlines the system requirements for optimal performance.

<table>
<thead>
<tr>
<th>Item</th>
<th>Minimum</th>
<th>Recommended</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software</td>
<td>* Citrix ICA client for Windows</td>
<td>Citrix ICA client for Windows</td>
</tr>
<tr>
<td>Internet Browser</td>
<td>IE 6 SP2, SSL 2 and 3 enabled</td>
<td>IE 6 SP2, SSL 2 and 3 enabled</td>
</tr>
<tr>
<td>Connection</td>
<td>56 KB</td>
<td>Broadband</td>
</tr>
<tr>
<td>Screen Resolution</td>
<td>1024 x 768</td>
<td>1024 x 768</td>
</tr>
</tbody>
</table>

*See the companion guide “VISUAL Liquid Web - Citrix client Installation” for details on installing Citrix. Citrix allows you to use complex hosted applications over the internet with only your computer and an internet connection.
About
This document is intended as a high-level guide for COV Anonymous Users of the Avizent VISUAL Liquid Web product. This document provides a description of the VISUAL Liquid Web application, including instructions for accessing and using the application, and how to reach technical support.

Text Conventions
The following text conventions are used in this document.

<table>
<thead>
<tr>
<th>Element</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>bold text</strong></td>
<td>Characters that you type exactly as shown; menus and menu commands,</td>
</tr>
<tr>
<td></td>
<td>command buttons, command prompts; list or drop-down boxes titles and</td>
</tr>
<tr>
<td></td>
<td>selections; tab and dialog box titles and options</td>
</tr>
<tr>
<td><strong>Italic Font</strong></td>
<td>Variables for which you supply a specific value; information that you</td>
</tr>
<tr>
<td></td>
<td>supply</td>
</tr>
<tr>
<td><strong>ALL CAPITALS</strong></td>
<td>Acronyms, names of certain commands, keys on the keyboard</td>
</tr>
<tr>
<td><strong>Initial Capitals</strong></td>
<td>Names of applications, screens, programs, field names</td>
</tr>
</tbody>
</table>

Graphic Alerts
The following graphic alerts are used in this document.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Caution Flag]</td>
<td>Alerts you to potential problems, such as data loss or security breaches.</td>
</tr>
<tr>
<td>![Example Icon]</td>
<td>Provides a hands-on interactive lesson, or indicates material that helps clarify the current discussion.</td>
</tr>
<tr>
<td>![Note Icon]</td>
<td>Alerts you to supplementary information.</td>
</tr>
<tr>
<td>![Tip Icon]</td>
<td>Provides additional information that may be helpful to task completion such as shortcuts.</td>
</tr>
</tbody>
</table>
Getting Started

VISUAL Liquid Web is an electronic forms processing and data capture system. VISUAL Liquid Web ensures that all the information necessary to submit a COV Employer’s Accident Report (EAR) is captured on its easy-to-use screens. This feature ensures that all EARs submitted have the minimum state required information completed.

VISUAL Liquid Web 2.2 integrates directly with the VISUAL Claims Studio™ software suite, so there is never a need to re-key information. Field and document level validation ensures that documents adhere to the configured document specific rules.

As an early innovator in the design of web site submission of electronic event and first reporting we formed EFROI.COM™. This online hosted service allows clients to electronically capture Event and State First Reports of Injury data over the web. EFROI.COM is the simple, fast, and cost-effective way to file events.

VISUAL Liquid Web users will also enjoy the ability to generate and print forms.
Accessing VISUAL Liquid Web

1. In your Internet browser’s address field, type https://apps.frankgates.com/vaea/auth/login.aspx and press Enter.

   **Result:** The Visual Liquid Web Intake home page displays.

2. Click the Log In button in the box on the upper left of the screen

   **Result:** The Applications box displays
3. Click Employee Accident Report in the Applications box.

**Result:** The Citrix logon script will run, followed by the appearance of the VISUAL Liquid Web log in screen.

**Note:** You do not need to fill the "Password" field. Skip this prompt and click on the Login button.
4. Click Login on the Login Screen.

**Result:** VISUAL Liquid Web appears.

If you have problems logging in, contact helpdesk@avizentrisk.com or 800-727-4283 for assistance.

**Closing the VISUAL Liquid Web Application**
To exit the application, on the File menu, select Exit. The application will close. If you have open EARs with unsaved changes, the system will prompt you to save the changes before closing.

**Accessing Technical Support**
Technical support for this Avizent product is available through the Help Desk (helpdesk@avizentrisk.com or 800-727-4283).
Navigating VISUAL Liquid Web

Once you are logged in, VISUAL Liquid Web’s home screen displays. The primary navigation for VISUAL Liquid Web is found in the toolbar and in the left pane. The larger Content pane is on the right. You can also navigate using the menus.
Menus
VISUAL Liquid Web contains two menus: File and Edit. Each menu’s options are explained below.

File
The File menu contains the following options:

- **New Document**—Enables you to open a new COV EAR.
- **Exit**—Closes the VISUAL Liquid Web application.

Edit
The Edit menu contains the following options. These options are only available when an EAR is open.

- **Cut**—Deletes the highlighted text and saves a copy of it on the clipboard.
- **Copy**—Copies the highlighted text to the clipboard.
- **Paste**—Pastes the text previously cut or copied to the clipboard.
- **Find**—Searches the open EAR for the text you specify.
Toolbar
The toolbar contains buttons which are shortcuts to various commands. The table below lists the standard toolbar buttons in VISUAL Liquid Web.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="New Document" /></td>
<td><strong>New Document</strong>—Enables you to enter a new EAR into the system.</td>
</tr>
</tbody>
</table>

Standard Buttons
In addition to the toolbar buttons, other buttons are available throughout the application. Not all buttons are available on all screens. The following table contains a listing of all of the buttons available in the application.

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Print" /></td>
<td><strong>Print</strong>—Generates an electronic copy (.PDF) of the EAR which can be printed.</td>
</tr>
<tr>
<td><img src="image" alt="Submit" /></td>
<td><strong>Submit</strong>—Submits the completed EAR to the system designated reviewer.</td>
</tr>
</tbody>
</table>
Content Pane

The Content Pane will display the Employer’s Accident Report.
Left Pane
The left pane contains the following areas.

- **User Information**—Displays the current day’s date and your application user name.
- **Validation Results**—Contains a listing of the data fields which are required for the COV EAR. This list is updated as you enter information, so that you can see at-a-glance which required fields still need to be completed.

<table>
<thead>
<tr>
<th>Fields</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>Employee First Name</td>
<td>Required</td>
</tr>
<tr>
<td>Employee Last Name</td>
<td>Required</td>
</tr>
<tr>
<td>Employer FEIN</td>
<td>data required</td>
</tr>
<tr>
<td>Date of Injury</td>
<td>data required</td>
</tr>
<tr>
<td>Employer Name</td>
<td>data required</td>
</tr>
<tr>
<td>Agency</td>
<td>data required</td>
</tr>
<tr>
<td>Social Security</td>
<td>data required</td>
</tr>
<tr>
<td>Type of Claim</td>
<td>data required</td>
</tr>
</tbody>
</table>

**Tip**—You can also double-click on an item in the Validation Results field’s list to jump to its entry field in the EAR.
Using VISUAL Liquid Web

Your main task in VISUAL Liquid Web will be to enter EARs (Employer’s Accident Report). This section provides information on this task as well as how to perform other auxiliary tasks such as printing an EAR.

Entering a New EAR

You can access the EAR entry form in one of two ways:

- From the File menu, select New Document, select EFROI, and then select COV EAR.
  **Result:** A blank COV Employer’s Accident Report displays.

- Click the New Document toolbar button, select EFROI, and then select COV EAR.
  **Result:** A blank COV Employer’s Accident Report displays.

REQUIRED FIELDS: Based on data processing needs, these are subject to change. Please consult with your HR Administrator to clarify which fields you are expected to complete.

Fields listed in the Validation Results area on the left pane are system required. They must be completed to be accepted by the MCI claim administrator. Please see your HR Administrator to determine which fields you are expected to complete as a Generic or anonymous user.
Example—The following example steps you through opening a COV Employer’s Accident Report form using the New Document toolbar button and entering information in all of the fields.

1. Click the **New Document** toolbar button, select **EFROI**, and then select **COV EAR**.
   
   **Result:** A blank COV Employer’s Accident Report displays. You can now start entering information into the form.

   ![Image of COV Employer's Accident Report](image)

   **Note**—It is your responsibility as an Anonymous User to complete the section of the EAR titled “This section to be completed by Employee/Supervisor.”
2. In the **Employer** field, click on the **Show Display** button. From the drop down selection fields, select an Agency, and any applicable sub-agency.

Result: The screen displays selected agency and sub-agency.

3. Click the **Show Display** button again.

Result: The names of applicable HR contacts defined at a selected sub-agency will display. If there are no contacts at that level, the names of the HR contacts at the Agency level will display.
4. Select the injured worker’s employer from the list.  
   **Result:** The employer’s information is displayed as shown in the example below.

   ![Employer Information Displayed](image)

5. With the employer’s information displayed, press **TAB**.  
   **Result:** The employer information is entered on the form and the cursor moves to the next data entry field on the form as shown in the example below.

   ![Next Data Entry Field](image)

   **Note**—Notice that after the injured worker’s employer was entered the Employer Name field was removed from the field list in the Validation Results area. The Name of Employer area is also no longer bordered in pink.
6. In the Validation Results area, double-click on **Social Security Number**.  
**Result:** The cursor is positioned in the Social Security Number field of the Employee Accident Report form.

7. Enter the injured worker’s **social security number**.
8. In the Validation Results area, double-click on Employee First Name. 

**Result:** The cursor is positioned in the First field.

- **Note**—Notice that after the injured worker’s social security number was entered that the Social Security Number field was removed from the field list in the Validation Results area. The Social Security Number field is also no longer bordered in pink.

9. Enter the injured worker’s first name.

10. In the Validation Results area, double-click on Employee Last Name. 

**Result:** The cursor is positioned in the Name of Employee (Last) field.

11. Enter the injured worker’s last name.
12. In the Validation Results area, double-click on **Date of Injury**.

   **Result:** The cursor is positioned in the Date of Injury field.

13. Click the **Date of Injury** drop-down arrow.

   **Result:** A Calendar displays.

14. Use the calendar to select the employee’s date of injury.

Continue entering additional information that you have available, following the included list of **Required Fields**. You are encouraged to complete as much of the form as possible. Once the form is as complete as possible, you can submit the Employer Accident Report. See **Submitting an EAR** for more information.

You also have the option of requesting that a notification be emailed to you, or anyone you specify, when the claim is submitted. See **Requesting a Submission Notification Email** for more information.

**Tip**—You can move from field-to-field on the form by pressing the **TAB** key.

It is recommended that you use the “Tab” button to move through the form. Note: Tabbing to a “Yes/No” type button field will automatically select the first choice. You may change your choice, or if you want to keep it empty, press your “ENTER” button on the keyboard to unselect.
Data Entry Features
The following features are available to ease your data entry:

■ **Required Fields**—The required fields have a pink border. They are also listed in the Validation Results area. The Validation Results area acts as a checklist for required information. As the required fields are completed, they are removed from the Validation Results area.

■ **Numeric Fields**—Information that is normally displayed with formatting, such as dashes in phone numbers or social security numbers, can be entered with or without the dashes.

■ **Drop-down Selections**—Enter the first character to move directly to that point in the selection list. Use Up and Down arrows to navigate further.
Submitting an EAR

Submitting an EAR “promotes,” or forwards, the document to the Named User for review. To submit an EAR, click the **Submit** button on the EFROI toolbar.

If you have previously saved the document, it is submitted to the system specified reviewer.

If you have not saved the document, you are prompted to enter a subject name.

![Subject Input Dialog]

**Note**—It is suggested that the subject include the claimant’s last name, first name and date of injury as shown above.

After you have entered a subject name and clicked OK, the document is submitted to the system specified reviewer.
Requesting a Submission Notification Email
You may request that an email notification be sent to you or someone else when the EAR that you are entering is submitted.

With the EAR open on your screen, place your cursor in the **Email Addresses to send submission notification** field as shown below:

In the **Email Addresses to send submission notification** field, enter the email address(es) of the individual(s) to receive submission notification.

- **Note**—To send to multiple addresses, insert a comma “,” between email addresses. **Do Not Use Any Spaces Between email Addresses.** There is no limit to the number of email addressees you can enter.

The system saves this notification and will send a submission notification email to the listed addresses when the EAR is submitted to the Named User.

Closing an EAR
If you need to close an open EAR, click on the X in the upper right corner of the EFROI toolbar. The EAR will close.

- **Caution**—If you close a new EAR without submitting it, all of the data entered will be lost.
Printing an EAR

Printing produces an electronic copy of the EAR which can then be printed in hard copy. When you are entering a new EAR, a **Print** button is available in the EFROI toolbar.

To print the EAR, follow the steps below:

1. Click the **Print** button.
   
   **Result:** A PDF version of the EAR is generated. Adobe Acrobat launches and displays the PDF on your screen.

15. Click the **Print** icon the Acrobat toolbar.

   **Result:** The Print dialog box displays.
16. Specify the desired settings and click **OK**.

**Result:** The EAR is printed to the specified printer.
Viewing/Updating an Open EAR

To view and/or update an open EAR, click on the desired EARs name from the open EAR tabs.

Tip—You can have up to 12 forms open at one time. When you try to open the 13th form, you will receive a message stating that you have reached the maximum number of open forms.
VISUAL Liquid Web

Index

A
About, 3
Accessing Technical Support, 7
Accessing VISUAL Liquid Web, 5

C
Closing an EAR, 23
Closing the VISUAL Liquid Web Application, 7
Content Pane, 11
Copyrights, 1

D
Data Entry Features, 21
Disclaimer of Warranty, 1

E
Edit, 9
Entering a New EAR, 13

F
File, 9

G
Getting Started, 4
Graphic Alerts, 3

L
Left Pane, 12

M
Menus, 9

N
Navigating VISUAL Liquid Web, 8

P
Printing an EAR, 24

R
Requesting a Submission Notification Email, 23

S
Standard Buttons, 10
Submitting an EAR, 22
System Requirements, 2

T
Text Conventions, 3
Toolbar, 10
Trademarks, 1

U
Using VISUAL Liquid Web, 13

V
Viewing/Updating an Open EAR, 26
VISUAL Liquid Web COV Anonymous User User Manual, 1